Capitolo 5
Software per la progettazione 

· Software per la progettazione

· Fritzing

· Arduino
· Pure Data
· TouchOSC
Questo 

Fritzing

Per la progettazione elettronica assistita, altrimenti chiamata EDA (Electronic Design Automation), l’offerta di programmi è molto vasta.

La scelta di Fritzing come programma EDA è soprattutto legata al fatto di essere un software libero e, cosa non meno importante, alla sua facilità d’uso.

Fritzing è nato soprattutto per aiutare gli sviluppatori dilettanti e professionisti di progetti orientati principalmente ad Arduino. Tuttavia, essendo la libreria open source praticamente inesauribile, si trovano progetti pronti all’uso per altre piattaforme come Picaxe, Parallax, Snootlab e naturalmente Raspberry Pi.

La caratteristica principale che lo distingue da altri software simili è l’interfaccia innovativa che permette la progettazione su breadboard, oltre alla classica progettazione tramite schema elettrico e PCB.

Il software è stato sviluppato e viene mantenuto da un gruppo di volontari dell’Interaction Design Lab di Potsdam (Germania), molto attivo e al quale va sicuramente tutto il nostro sostegno. Invitiamo pertanto il lettore a considerare di effettuare una donazione, nel caso venisse usato il software, che è disponibile nell’area download del sito all’indirizzo http://fritzing.org. Sono supportate le seguenti piattaforme.

Windows (dalla versione XP in poi).

OS X (dalla versione 10.5 in poi).

Linux (64 e 32 bit, con libc uguale o superiore alla versione 2.6).

Una volta scaricato il file per il proprio sistema operativo, la finestra principale di Fritzing appare simile a quella illustrata nella Figura 4.20.
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Figura 4.20 Finestra principale di Fritzing (versione 0.7.12 del 13/02/2013).

Per Raspbian, è disponibile una versione ancora in fase di testing. Si può installare in Raspberry Pi, ma è consigliabile lavorare con un altro PC per produrre i layout dei progetti.

Per chi volesse provare Fritzing in Raspbian, può installarlo digitando da una shell di LXTerminal i comandi:

sudo apt-get update

sudo apt-get install fritzing

Una volta installato, il programma si troverà nel menu di avvio sotto Electronics.

Interfaccia

Premesso che il software è troppo esteso per una trattazione approfondita, daremo le informazioni necessarie alla realizzazione dei progetti del libro.

Prima di spiegare i controlli e i menu dell’interfaccia è utile imparare come muoversi nella finestra principale senza fatica.

Lo zoom può essere effettuato comodamente tramite la rotella del mouse, oltre che con il controllo specifico in basso a destra nella finestra.

Lo spostamento nella finestra può essere effettuato premendo la barra spaziatrice e trascinando il mouse (il cursore diventa la classica “manina”). La stessa operazione può venire effettuata con la rotella del mouse più il tasto Ctrl.

Detto questo, possiamo analizzare la finestra principale e vedere che è suddivisa in tre sezioni principali. La parte centrale, più grande, è dedicata alla visualizzazione del layout, che può essere di tre tipi:

vista Breadboard (accessibile anche con Ctrl+1);

vista Schema (accessibile anche con Ctrl+2);

vista PCB (accessibile anche con Ctrl+3).

Vista Breadboard

È la vista ideale per coloro che vogliono sperimentare velocemente un prototipo su breadboard. La breadboard visualizzata ha un aspetto realistico e riporta fedelmente la stessa disposizione standard dei collegamenti centrali e dell’alimentazione laterale.

Anche i componenti elettronici hanno l’aspetto realistico e vanno “infilati” nei fori esattamente come si farebbe con una vera breadboard.

Vista Schema

Per coloro abituati a progettare su schema elettrico, la vista Schema permette di collegare i componenti attraverso i simboli elettrici. Da notare che il circuito creato in questo modo non viene riportato nella breadboard, essendo la simbologia dei componenti molto diversa. Si consiglia di partire a progettare dalla vista Breadboard e di adattare manualmente lo schema elettrico in un secondo tempo.

Vista PCB

È l’ambiente ideale per creare una PCB perfetta. Dopo aver sperimentato con la bread­board è auspicabile dare al progetto un aspetto più professionale e soprattutto più solido.

Dalla vista PCB si può creare il file di produzione per la stampa di una vera basetta da mandare al servizio online di Fritzing Fab o a un altro stampatore di PCB. In alternativa, per chi ha tempo e voglia, è possibile stampare il file PCB su un foglio di acetato e creare la basetta in casa. Il risultato è sicuramente un po’ meno professionale, ma forse è più “cool”.

Pannello Componenti

Nella parte destra della finestra principale è presente il pannello Componenti (Figura 4.21). Qui sono disposte in ordine diverse librerie di componenti elettronici di tutti i tipi. Se un componente particolare dovesse mancare, è comunque possibile modificarne uno o crearlo da zero attraverso l’editor interno (al momento in cui scriviamo è in fase di sviluppo un editor ancora più sofisticato). I componenti vanno posizionati nelle varie viste con il semplice trascinamento del mouse. A seconda della vista utilizzata, ogni componente ha un aspetto diverso e, ovviamente, non possono essere usati componenti incompatibili con quel tipo di vista.
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Figura 4.21 Pannello Componenti.

Ogni libreria è suddivisa in categorie. Nella libreria Core, quella con i componenti più usati, sono disponibili le seguenti categorie.

Basic: resistori, condensatori, induttori, diodi, transistor, FET e mystery part, un componente di cui non è specificato l’uso ma che si può editare.

Input: potenziometri/trimmer, compensatori, encoder, pulsanti, interruttori, fotocellule, sensori di vario tipo, accelerometri, antenne e altro ancora.

Output: LED, display a 7 segmenti, schermi LCD, altoparlanti piezo e normali, microfoni, motori DC, motori servo, motori stepper, solenoidi, relè e altro ancora.

ICs: circuiti integrati più utilizzati e quarzi.

Power: batterie, regolatori di tensione e altro ancora.

Connection: pin header di vario tipo, terminali, prese USB, shield per Arduino, Xbee, Motor Driver e altro ancora.

Microcontroller: Arduino, Netduino, Picaxe, Parallax e altro ancora. 

Vista Breadboard: elementi aggiuntivi per la breadboard (millefori, ponticelli).

Vista Schema: elementi aggiuntivi per lo schema elettrico (simboli elettrici, note del progettista).

Vista PCB: elementi aggiuntivi per il circuito stampato (jumper, vie, fori, piazzole ramate e altro).

Tools: blocco note e righello con misure in centimetri e pollici.

C’è da dire che ogni versione aggiornata di Fritzing aggiunge sempre nuovi componenti e farne un elenco completo è quindi impossibile. Altre librerie sono addirittura aggiornate in tempo reale tramite la connessione Internet al sito. Fra le più interessanti, citiamo:

Arduino: libreria dedicata ai prodotti Arduino;

Parallax: libreria dedicata ai prodotti Parallax;

Picaxe: libreria dedicata ai prodotti Picaxe;

Sparkfun: libreria dedicata ai prodotti Sparkfun;

Snootlab: libreria dedicata ai prodotti Snootlab;

Inoltre, la sezione con i contributi degli utenti viene sempre aggiornata online. Chiunque voglia condividere il proprio progetto fatto con Fritzing, lo può liberamente mettere a disposizione della community, registrandosi gratuitamente al sito fritzing.org.

Nel pannello Componenti si può creare anche una propria libreria personalizzata.

Infine, un comodo motore di ricerca consente di cercare i componenti e di gestire i file del pannello Componenti.

Pannello Adafruit

Si consiglia di scaricare e di aggiungere a Fritzing il pannello dei componenti di Adafruit dal sito https://github.com/adafruit/Fritzing-Library. Una volta scompattato il file ZIP, è possibile installare il pannello aprendo il file AdaFruit.fzbz. Nella stessa cartella si trova anche il file CircuitPlayground.fzbz, che installa alcuni componenti “sorridenti”, adatti alla programmazioni di layout per bambini.

Inspector

Selezionando un elemento dal pannello Componenti e quando l’elemento è stato posizionato nella vista, è possibile visualizzare e/o modificare le sue proprietà. Per esempio, selezionando un resistore standard e posizionandolo nella breadboard se ne possono modificare le proprietà, come illustrato nella Figura 4.22.

package: più THT (terminali passanti) o SMD (Surface Mount Device).

tolerance: tolleranza da +/– 0.05% a 20%.

bands: 4 o 5 anelli.

resistenza: i valori standard più usati.

power: qualsiasi potenza.

pin spacing: spaziatura da 100 mil (in piedi) a 800 mil (non ha senso nella vista Bread­bord, ma solo nella vista PCB).

part number: testo libero per inserire il numero della parte.
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Figura 4.22 Pannello Inspector relativo a un resistore.

Esempi pratici

Per capire come usare Fritzing è consigliabile iniziare a sperimentare aprendo alcuni dei numerosi esempi pratici dal menu File > Apri esempio, riguardanti la breadboard e il relativo schema/PCB, suddivisi per tipologia.

Arduino: progetti con Arduino completi di riferimenti agli sketch online.

Fritzing Starter Kit: progetti con Arduino e Fritzing Starter Kit, un kit per principianti messo a disposizione dal sito fritzing.org.

Fritzing Super Upgrade Kit: progetti con Arduino e Fritzing Super Upgrade Kit, un kit avanzato messo a disposizione dal sito fritzing.org.

Fritzing EDGY: progetti con lo shield EDGY, prodotto e messo a disposizione dal sito fritzing.org.

All: lista completa di tutti i progetti.

Raspberry Pi, semplice progetto per controllare un LED

La Figura 4.23 illustra un semplice esempio di collegamento di un LED alle porte GPIO di Raspberry Pi. Il progetto utilizza solo un LED e un resistore da 330 Ω. Notare che nella finestra è riportato un riquadro per inserire le note.

Dal pannello Componenti, selezionare l’icona con il lampone (Raspberry Pi) e trascinarla nella finestra del progetto.

Il filo rosso va collegato al piedino 17 della porta GPIO al terminale positivo della breadboard.

Il filo nero va collegato da GND (Ground) della porta GPIO al terminale negativo della bread­board.

Il resistore da 330 Ω va da GND al terminale negativo (catodo) del LED.

Il filo rosso dal polo positivo va collegato all’anodo del LED.

Per il codice di funzionamento del layout con Fritzing, vedere il paragrafo “Python” in questo stesso capitolo.
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Figura 4.23 Il progetto LED nella vista breadboard.

Per completezza riportiamo anche la vista schema elettrico e vista PCB (Figura 4.24).

Stampa PCB

Abbiamo visto quanto sia facile progettare un circuito sperimentale su breadboard, ma con Fritzing è possibile creare un progetto per produrre un circuito stampato di qualità professionale.
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Figura 4.24 Vista schema elettrico e vista PCB del progetto Fritzing.

Fritzing Fab è un servizio online di stampa PCB fornito dal sito fritzing.org. Una volta terminato il progetto, è sufficiente effettuare l’upload del o dei file in formato Fritzing, e ordinare la quantità desiderata di PCB. È possibile effettuare ordini anche di un solo circuito stampato, ma è consigliabile aumentare il numero ad almeno due o quattro unità per risparmiare sui costi. Il pagamento avviene online tramite PayPal e la consegna avviene entro circa un paio di settimane. La qualità del prodotto giustifica il costo decisamente più alto di altri produttori di PCB, e se volete fare un figurone, ne vale veramente la pena. Il prodotto è molto curato e viene controllato prima di essere stampato. Le serigrafie sono nere su smalto di colore bianco panna. Le basette PCB arrivano già tagliate in pezzi singoli e arrotondate sugli angoli.

Vista PCB

La Figura 4.25a mostra lo stato dei collegamenti nella vista PCB quando si passa da una vista Breadboard. Da quello che si vede, la cosa non è confortante. Tutto risulta disordinato

Ci sono alcune cose che si possono fare.

Innanzitutto, è necessario spostare manualmente all’interno della PCB i componenti e i cavi rimasti all’esterno. Basta selezionare gli elementi con il mouse e portarli all’interno del rettangolo verde corrispondente alle dimensioni della breadboard.

Dopodiché, a seconda della complessità del circuito, è consigliabile impostare la PCB a uno o due layer (strati). Per fare questo, una volta selezionata la PCB, è sufficiente andare alla voce layers dall’Inspector e impostare il valore su one layer (single sided) o su two layers (double sided). Questa operazione è molto importante ai fini della disposizione delle piste ramate, dei componenti e delle serigrafie.

Supposto che il nostro circuito sia a singola faccia (single sided), bisognerà anche dimensionare la PCB in modo da non sprecare spazio. Sempre dall’Inspector, si possono impostare le dimensioni della PCB, che nel nostro caso può essere lunga 60-80 mm.

A questo punto, basta premere il pulsante Autoinstrada per effettuare automaticamente un instradamento delle piste di rame in modo ottimale (Figura 4.25b), anche se non definitivo.
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Figura 4.25 Vista PCB con un circuito visibilmente disordinato (a) e quando viene autoinstradato successivamente (b).

Ovviamente, si può lavorare con il mouse sulle piste e, spostando opportunamente i componenti, si può arrivare a un risultato molto più che accettabile, come illustrato nella Figura 4.26a. Volendo, è possibile riempire di rame gli spazi vuoti in modo automatico tramite il comando Copper Fill del menu Routing (Figura 4.26b).

Questa operazione è consigliata perché la ramatura funge anche da schermo per eventuali interferenze radio.
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Figura 4.26 Il progetto dopo l’instradamento manuale (a) e dopo il riempimento automatico Copper Fill (b).

Dallo stesso menu Routing, si può effettuare un controllo delle piste tramite il comando Design Rules Check (Ctrl+Shift+D). Se compare la finestra della Figura 4.27a significa che tutto è a posto e si può mandare in stampa la PCB. Altrimenti, se le piste sono troppo vicine o se ci sono degli errori, apparirà l’avviso della Figura 4.27b. Bisognerà correggere manualmente gli errori segnalati in rosso nella PCB e ripetere il controllo.
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Figura 4.27 Il progetto è pronto per la produzione (a). Il progetto contiene errori che vanno corretti (b).

Esportazione del file di produzione

Come in un vero programma professionale, Fritzing offre varie opzioni per l’esportazione del file di produzione.

Oltre al pulsante Order PCB per l’ordine immediato online, premendo il pulsante Export for PCB o dal menu File > Esporta, è possibile accedere a una serie di opzioni.

Etchable (PDF): documento PDF per l’incisione.

Etchable mirrored (PDF): documento PDF speculare per l’incisione.

Etchable (SVG): documento SVG per l’incisione.

Etchable mirrored (SVG): documento SVG speculare per l’incisione.

Extended Gerber (RS-274X): documento Gerber (per servizi di stampa PCB professionali).

Dal menu File si può ulteriormente esportare il progetto in vari formati immagine, come lista componenti e XML Netlist (Figura 4.28a). Esportando come documento Etchable (PDF) (Figura 4.28b) si può stampare il circuito su un foglio di acetato con una stampante laser. Una volta impressionato e sviluppato il circuito su una basetta ramata presensibilizzata, si potrà inciderla in un bagno di cloruro ferrico.
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Figura 4.28 Opzioni di esportazione del progetto (a). Documento PDF per l’incisione fai-da-te (b).

Per mandare a un servizio di stampa PCB il file di produzione, nella quasi totalità dei casi, è necessario esportarlo nel formato Extended Gerber (RS-274X), facendo attenzione che i file prodotti non contengano errori. Di soliti i servizi di stampa PCB fanno pagare a parte il controllo e richiedono almeno una giornata lavorativa in più.

Per il controllo dei file Gerber si può utilizzare uno dei tanti Gerber Viewer freeware disponibili online. Uno è GerbView, disponibile gratuitamente sul sito Sourceforge.net. Una volta prodotti i file Gerber, è sufficiente importarli tutti nel viewer per controllare a uno a uno i vari layer di produzione, ovvero il layer del lato rame, della serigrafia, dei fori, della copertura in rame ed eventuali altri layer (Figura 4.29).
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Figura 4.29 I file Gerber caricati nel software GerbView.

NOTA

Il file Gerber è stato introdotto da Gerber Systems Corp. per la produzione industriale di PCB su macchine CNC. Lo standard industriale prevede la presenza di un numero qualsia­si di file inerenti le varie fasi di lavorazione: incisione, maschere di saldatura, fresatura, foratura, serigrafia e così via. I file sono in formato testo, pertanto il primo controllo visivo può essere effettuato anche aprendoli con un normale blocco note.

Arduino

Perché installare Arduino in Raspbian? La risposta è semplice. Arduino si è imposto da anni come una solida piattaforma di sviluppo hardware e software. Come si vedrà nei prossimi capitoli, è possibile utilizzare i pin della porta GPIO di Raspberry Pi per la connessione a sensori, LED, motori e qualsiasi altro attuatore.

Chi ha si esperienza con la piattaforma Arduino, lo potrà utilizzare insieme a Raspberry Pi, in modo da creare un potente sistema interattivo e allargare le potenzialità delle due piattaforme in modo esponenziale.

Chi non ha mai usato Arduino potrà trovare queste pagine estremamente utili e scoprire i vantaggi delle due piattaforme messe assieme.

Un altro motivo per cui è consigliabile l’uso di Arduino insieme a Raspberry Pi è l’enorme quantità di librerie e di esempi nel vasto mare di Internet.

Un qualsiasi progetto per Arduino può essere integrato in Raspberry Pi come estensione hardware/software.

Ultimo, ma non meno importante motivo, è che la piattaforma Arduino è talmente ricca di prodotti aggiuntivi (shield) che si possono aumentare a dismisura le potenzialità del sistema integrato Arduino-Raspberry Pi.

Installazione

Sicuramente non è questa la sede per approfondire i temi su Arduino, per cui consigliamo caldamente la lettura de Il manuale di Arduino di Maik Schmidt (Apogeo, 2011), nel quale si può trovare specifico materiale didattico.

L’interfaccia IDE (Integrated Development Environment) di Arduino, essendo basata su Java, è disponibile per tutte le piattaforme informatiche, Raspbian compreso.

Una volta installata su Raspbian, si potranno compilare alcuni sketch per progetti che verranno impiegati per controllare l’hardware, come spiegato nel Capitolo 8.

L’ultima versione del software Arduino disponibile nel momento in cui scriviamo è la 1.0.3, scaricabile gratuitamente dal sito ufficiale http://arduino.cc per piattaforme Windows, Mac OS X, Linux (32 bit e 64 bit) e come file sorgente per gli sviluppatori.

Per Raspbian, la versione attuale dell’IDE di Arduino è la 1.0.1. Per l’installazione automatica, basta essere collegati in Rete e digitare in una shell di LXTerminal il seguente comando:

sudo apt-get update

sudo apt-get install arduino

È sempre consigliabile eseguire un comando update prima di installare qualsiasi pacchetto dal repository Raspbian.

Al termine dell’installazione si potrà trovare la voce Arduino nel menu di avvio alla voce Electronics.

Attenzione! Non è ancora il momento di lanciare l’applicazione. Per programmare una scheda Arduino basta collegarla con un cavo USB a un qualsiasi computer, che solitamente è ricco di porte USB. Ma per programmare una scheda Arduino da Raspberry Pi, dotato solo di due porte USB già collegate a un mouse e a una tastiera, bisogna obbligatoriamente collegare un hub USB esterno.

Si consiglia di usare un hub alimentato oppure un hub con non più di quattro porte USB. In questo caso, sarà necessario un alimentatore USB per Raspberry Pi in grado di supportare un assorbimento di almeno 2 ampere. In caso contrario si rischia di danneggiare la porta USB o causare malfunzionamenti nei dispositivi collegati.

Quando si avvia l’IDE Arduino da altri computer si possono “vedere” le porte seriali virtuali installate come COM o tty, a seconda della piattaforma usata.

Per poter accedere alla porta seriale da Raspbian è necessario che l’utente abbia i permessi di accesso. Questa operazione è possibile eseguendo i comandi che aggiungono l’utente pi (utente di default) ai gruppi tty e dialout. Quindi, prima di eseguire l’IDE Arduino, da una shell di LXTerminal digitare i seguenti comandi:

sudo usermod -a -G tty pi

sudo usermod -a -G dialout pi

A questo punto è possibile eseguire l’IDE di Arduino. Appare una finestra che riporta il nome dello sketch (così viene chiamato in Arduino il listato del programma), come illustrato nella Figura 4.8.
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Figura 4.8 L’interfaccia dell’IDE di Arduino.

Nota

Dalla versione 1.0.1, l’interfaccia è stata completamente localizzata in italiano. Per impostare la lingua, aprire il menu File > Preferences e scegliere la lingua nella casella Editor Language.

Il nome dello sketch viene numerato automaticamente all’apertura, aggiungendo il mese, il giorno e una lettera progressiva dalla “a” alla “z” ogni volta che si crea un nuovo file dal menu o con Ctrl+N.

Prima di aprire o scrivere uno sketch, l’operazione da effettuare è quella di verificare la connessione alla porta seriale virtuale.

Dal menu Strumenti > Porta seriale, selezionare la porta seriale in uso, ovvero quella a cui è collegata la scheda Arduino. Molto probabilmente sarà una porta dal nome simile a /dev/ttyACM0.

Sempre dal menu Strumenti, selezionare il tipo di scheda Arduino collegata, per esempio, Arduino UNO.

Esempi di codice

Dal menu File si può accedere alla voce Esempi per aprire una serie di esempi pronti all’uso. È inutile dire che tutte le pubblicazioni su Arduino invitano a provare Blink, accessibile dal menu File > Esempi > 01.Basics > Blink. Si tratta di una sorta di “Hello World!” per controllare che tutto funzioni (Figura 4.9). Se tutto è collegato in modo corretto, ovvero se l’IDE “vede” la scheda Arduino collegata alla porta USB, è possibile procedere alla compilazione e al caricamento dello sketch in memoria di Arduino.
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Figura 4.9 L’esempio Blink accessibile dal menu File > Esempi > 01.Basics > Blink.

Caricamento dello sketch

Una volta caricato lo sketch di esempio Blink, si aprirà una nuova finestra simile a quella della Figura 4.10 con tutto il listato del programma commentato riga per riga, ovviamente in inglese. A beneficio dei principianti e di chi non è avvezzo al linguaggio di programmazione, diamo una breve spiegazione del listato.

Per prima cosa, seguendo fedelmente la tipica sintassi del linguaggio C e C++, le indicazioni di commento alle righe di codice sono di due tipi.

Viene usata la doppia barra (//) a inizio o a fine riga per commentare una riga isolata. Il testo apparirà in grigio dopo il segno //.
Viene usata la barra più l’asterisco (/*) all’inizio di un insieme di righe e l’asterisco più la barra (*/) alla fine dell’insieme di righe. Tutto il testo all’interno del segno /* e del segno */ verrà visualizzato in grigio.

/*
  Blink
  Turns on an LED on for one second, then off for one second, repeatedly.
  This example code is in the public domain.
 */

void setup() {
  // initialize the digital pin as an output.
  // Pin 13 has an LED connected on most Arduino boards:
  pinMode(13, OUTPUT);     
}

void loop() {
  digitalWrite(13, HIGH);     // set the LED on
  delay(1000);               // wait for a second
  digitalWrite(13, LOW);     // set the LED off
  delay(1000);              // wait for a second
}

Ecco la traduzione del testo commentato:

/*Blink
Accende un LED per un secondo, poi lo spegne per un secondo, ripetutamente.
Questo esempio di codice è di dominio pubblico.
*/
// Inizializza il pin digitale come uscita.
// Il pin 13 ha un LED interno nella maggior parte delle schede Arduino:
// accende il LED
// attende un secondo
// spegne il LED
// attende un secondo

A questo punto, non ci resta che verificare, compilare e caricare in memoria di Arduino il programma Blink.

Verifica e compilazione

Il file di esempio è sicuramente funzionante e non servirebbe alcuna verifica. Ma per spiegare la procedura da seguire per qualsiasi altro sketch, diciamo che è consigliabile effettuare sempre il controllo del codice con relativa compilazione prima del successivo caricamento del programma in memoria del processore di Arduino.
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Figura 4.10 Il listato dello sketch di esempio Blink.

Nella barra degli strumenti sotto i menu, il pulsante con l’icona con un segno di spunta si chiama Verifica, seguito dal pulsante Carica con l’icona di una freccia.

Premendo sul pulsante Verifica, il listato verrà compilato e, se non ci sono errori, apparirà dopo qualche secondo la scritta Compilazione terminata nella finestra di controllo in basso. Qui viene riportata anche l’indicazione della dimensione di memoria occupata dallo sketch e della memoria disponibile.

In caso di errore di compilazione, verranno segnalati in questa stessa finestra tutti gli errori e i riferimenti alle righe di codice che li contengono. Se non si riesce a ottenere la compilazione del codice, è inutile procedere alla fase successiva del caricamento in memoria, in quanto il sistema operativo del processore (bootloader) non può accettare di caricare un programma anche con un solo errore perché ne causerebbe il crash.

Caricamento in memoria

Una volta compilato con successo il codice, è possibile caricare il programma nell’EPROM del processore, ovvero nella sua area di memoria riscrivibile.

Premendo il pulsante Carica, il codice verrà compilato ancora una volta per sicurezza e caricato in memoria in Arduino. Nel frattempo una barra di progresso visualizzerà lo stato di scrittura della EPROM.

Al termine del caricamento, se non si verificano problemi con l’hardware, apparirà nella finestra in basso la scritta Caricamento terminato. Se per qualche motivo (non imputabile a errori di compilazione) il caricamento non dovesse andare a buon fine, nella stessa finestra in basso apparirà l’indicazione del problema. Spesso succede che la porta seriale virtuale non sia selezionata o che non sia stata selezionata la scheda corretta nel menu Strumenti > Tipo di Arduino. A volte, è sufficiente verificare questi problemi e riprovare il caricamento.

Una volta caricato in memoria lo sketch Blink, senza aggiungere nulla ai piedini corrispondenti alle porte della scheda, si vedrà il LED incorporato lampeggiare a intervalli di un secondo.

Volendo, si può aggiungere un LED esterno al pin 13 (anodo) e al pin GND (catodo), come illustrato nella Figura 4.11.

[image: image14.jpg]



Figura 4.11 Un LED collegato al piedino 13 e al piedino GND di una scheda Arduino UNO.

Modificare lo sketch

Senza voler toglier spazio alle pubblicazioni dedicate alla programmazione di Arduino, diamo solo alcune semplici indicazioni per modificare lo sketch di esempio visto prima. Le modifiche sono riportate in grassetto:

void setup() {
  pinMode(12, OUTPUT);
}

void loop() {
  digitalWrite(12, HIGH);
  delay(500);
  digitalWrite(12, LOW);
  delay(500); 
}

Compilando e caricando il codice così modificato, il LED collegato al pin 12 e al pin GND avrà un intervallo di lampeggio ridotto a mezzo secondo (500 millisecondi) impostato dalla funzione delay(500).

NOTA

Gli altri progetti con Arduino e Raspberry Pi sono illustrati nel Capitolo 8.

Sketchbook

Dopo aver modificato questo e altri sketch di esempio o averne creati da zero, è possibile salvare i file tramite il menu File > Salva con nome oppure direttamente con File >Salva. Gli sketch verranno salvati nella cartella di default del programma. In questo modo li si può ritrovare nel menu File > Cartella degli sketch. Si può lasciare la data messa in automatico nel nome de file e aggiungere la tipologia del programma, per esempio “Sketch_apr25a_controllo_LED”. È un metodo consigliato per lavorare con ordine.

Dalla versione 1.0, l’estensione dei file di Arduino è cambiata in .ino. Si possono ancora aprire i file con la vecchia estensione .pde, ma è consigliabile ricompilarli e risalvarli con la nuova estensione. Alcuni cambiamenti al codice riguardano le librerie usate e alcune parole della sintassi. Per esempio, dalla versione 1.0, la parola chiave BYTE non è più supportata e, per mandare un singolo byte, lo si deve sostituire con la funzione Serial.write().

Risorse

C’è davvero molto in Rete su Arduino e sarebbe impossibile fornire un elenco aggiornato di tutto ciò che evolve intorno a questo hardware straordinario.

Per chi vuole approfondire la conoscenza hardware e software di Arduino, ci limitiamo a segnalare il già citato Manuale di Arduino di Maik Schmidt (Apogeo 2011), come libro di riferimento in lingua italiana.

Visitando il sito ufficiale http://www.arduino.cc, si può trovare tutta la documentazione, le librerie di riferimento, gli esempi di codice, il forum e i link a innumerevoli altre risorse online.

Pure Data

Pure Data, chiamato anche brevemente Pd, è un ambiente di programmazione grafico studiato essenzialmente per applicazioni audio, video e per l’elaborazione grafica in tempo reale. Oltre a essere comunemente utilizzato per l’intrattenimento e spettacoli di musica dal vivo, Pd viene impiegato per la creazione di effetti sonori, la sintesi, la composizione assistita, l’analisi audio, l’interfacciamento con sensori, il controllo di robot e di telecamere e molto altro ancora.

Ovviamente, di tutte le possibilità di programmazione di Pure Data, tratteremo solamente quegli aspetti strettamente legati alla progettualità del libro e daremo solo qualche indicazione di massima a chi è digiuno totalmente di nozioni di programmazione.

Lo scopo di questo capitolo è che chiunque possa essere in grado di aprire l’interfaccia del software e operare con i progetti senza troppe difficoltà.

Pure Data è stato scritto e viene mantenuto da Miller Puckette del dipartimento di musica dell’Università della California a San Diego e include il lavoro di molti sviluppatori che hanno dato origine a una comunità molto attiva sul sito http://www.puredata.info.

Pure Data è disponibile gratuitamente con licenza GNU per le piattaforme Windows, Mac OS X, Linux e Debian, così come per le piattaforme mobili come iPhoneOS, Android e Maemo (Scratchbox). Essendo open source, sono disponibili anche i file sorgente per gli sviluppatori.

Oltre a poter scaricare liberamente la versione aggiornata di Pure Data (al momento Pd-extended 0.43.4), sul sito puredata.info si possono trovare moltissime risorse per l’apprendimento e lo sviluppo del software. Tra tutti i manuali online, purtroppo ne manca uno in italiano.

Per l’installazione su Raspbian è disponibile un link dedicato: http://puredata.info/docs/raspberry-pi. Da questo link si possono trovare le istruzioni per installare l’ultima release del software, che riportiamo qui sotto. Da una shell di LXTerminal digitare i seguenti comandi:

sudo add-apt-repository "deb http://apt.puredata.info/releases `lsb_release -c | awk '{print $2}'` main"
 sudo apt-key adv --keyserver keyserver.ubuntu.com --recv-key 9f0fe587374bbe81
 sudo apt-key adv --keyserver keyserver.ubuntu.com --recv-key D63D3D09C39F5EEB
 sudo apt-get update
 sudo apt-get install pd-extended

Una volta scaricato e installato il pacchetto Pd-Extended, si potrà avviare Pure Data dal menu di avvio sotto la voce Programming. La finestra principale si presenterà simile alla Figura 4.12.
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Figura 4.12 La finestra principale di Pure Data.

NOTA

Nella versione disponibile nel momento in cui scriviamo non sono stati risolti alcuni problemi audio HDMI del driver ALSA, per cui apparirà un messaggio audio I/O error. Nonostante questo messaggio, l’audio in uscita è disponibile correttamente.

Programmazione grafica

I programmi tradizionali di sviluppo software sono basati su linguaggi a basso o alto livello con lo scopo di compilare applicazioni eseguibili su diversi sistemi operativi.

Questo metodo, di solito, risulta difficile a coloro che sono digiuni di programmazione o hanno scarse conoscenze informatiche. Bisogna per forza impararne la sintassi o, perlomeno, avere qualche conoscenza di C, Java, Basic e affini.

La caratteristica principale che contraddistingue Pure Data dai programmi compilati è la sua capacità di elaborazione in tempo reale in un ambiente grafico.

Le righe di codice che solitamente descrivono le funzioni di un programma sono state sostituite con oggetti visivi che possono essere inseriti e modificati nella finestra del progetto a piacere.

Per questo motivo, i programmi Pd vengono chiamati patch, perché gli elementi grafici nella finestra vengono collegati proprio come si fa con i cavi audio che vengono usati per i collegamenti in una patchbay audio.

I collegamenti fra i vari oggetti della patch interagiscono secondo modalità prestabilite della libreria di riferimento caricata all’avvio di Pd. Quindi si comportano esattamente come previsto e sempre in tempo reale. Significa che non è necessaria alcuna compilazione di un “listato” perché i collegamenti fra gli oggetti sono consentiti dalla “semantica” del linguaggio utilizzata per costruirli. In altre parole, un oggetto può essere collegato a un altro tramite “cavi di collegamento” alle “prese e spine” di un altro oggetto solo se l’oggetto stesso può venire creato. Pertanto, non ci possono essere errori di compilazione a monte.

Come già detto, il vantaggio di Pure Data è che funziona in tempo reale, pertanto è possibile apportare modifiche al programma anche se è in esecuzione. Si possono vedere o sentire immediatamente i risultati senza dover compilare nulla manualmente.

La costruzione della patch grafica è semplice e si avvale di pochi comandi da tastiera o da menu. Nella parte alta della finestra principale sono disponibili i seguenti menu operativi e di servizio.

File.

Edit.

Put.

Find.

Windows.

Media.

Help.

Per prima cosa, visto che Pd è soprattutto multimediale, è opportuno controllare la configurazione audio e MIDI dal menu Media.

La Figura 4.13a illustra le configurazioni di base per la periferica audio e MIDI installata nel proprio sistema. Nella pagina di test si possono verificare i segnali audio e MIDI. Attivando una delle caselle TEST TONES, si dovrebbe udire un suono dalle casse collegate alla scheda (o dall’altoparlante del monitor/TV HDMI). Attivando la casella MIDI OUT, si dovrebbe sentire una nota dalla periferica MIDI collegata.
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Figura 4.13 Pagina di configurazione e test per la configurazione audio e MIDI (a). Menu Help > Pd Help Browser (b).

ATTENZIONE

Bisogna tenere presente, che quanto detto per la configurazione audio/MIDI di Pure Data (ma anche di altri programmi multimediali) vale per tutti i sistemi operativi, ovvero Windows, Mac, Linux o Raspbian, solo che per quest’ultimo non esiste una periferica audio/MIDI integrata nel computer. L’audio viene gestito dal driver audio ALSA o OSS disponibile in Raspbian, ma il MIDI non viene gestito. È possibile risolvere il problema installando una periferica audio/MIDI USB o addirittura costruire un’interfaccia MIDI per Raspberry Pi, come spiegato nel Capitolo 8.

NOTA

ALSA è l’acronimo di Advanced Linux Sound Architecture. È un componente del kernel Linux in grado di gestire l’audio in ingresso e uscita in modo più efficiente rispetto al precedente sistema OSS (Open Sound System). In Raspbian è consigliabile disattivare l’ingresso audio dalla configurazione Input device del driver bcm2835 ALSA di Pure Data se non è presente una scheda audio USB con ingresso audio.

A chi non ha mai visto in funzione Pure Data, si consiglia di aprire il menu Help > Pd Help Browser per sperimentare qualche esempio nel browser del programma, come illustrato nella Figura 4.13b. Gli esempi sono numerosi e di tanti tipi e non c’è da stupirsi se dopo un po’ Pure Data comincia a diventare un amico insostituibile.

Oggetti, messaggi e numeri 

Aprendo una patch di esempio (anche la precedente finestra di configurazione audio e MIDI è una patch Pd!), si nota che è formata da riquadri collegati fra loro da sottili fili. All’interno di ogni riquadro ci può essere un testo o un numero, oppure nulla se si tratta di un pulsante disattivato. I fili collegano i riquadri fra di loro attraverso dei piccoli rettangoli posti sui bordi o sugli angoli. Il numero di questi piccoli rettangoli varia a seconda della funzione del riquadro.

I riquadri sono essenzialmente di tre tipi (Figura 4.14):

oggetto;

messaggio;

numero.
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Figura 4.14 Tre tipi di riquadro: oggetto messaggio e numero.

Oggetto

Il riquadro “oggetto” ha un bordo rettangolare e interpreta il testo al suo interno per creare un oggetto quando si carica una patch. Quello che si può scrivere all’interno non è un testo qualsiasi e, ovviamente, si possono scrivere nomi di oggetti facenti parte di una libreria. In altre parole, l’oggetto di questo tipo corrisponde alla “classe” di un programma tipo C. 

Un oggetto può contenere centinaia di classi differenti, compresi oscillatori, generatori di inviluppo e altri moduli di elaborazione del segnale, in funzione del testo al suo interno.

Per sapere “cosa” scrivere all’interno di un oggetto bisogna fare riferimento alla documentazione online. C’è da dire che una volta aperti una decina di esempi pratici, si impara presto a inserire gli oggetti solamente copiando e incollando il testo.

Messaggio

Il riquadro “messaggio” è un rettangolo a forma di bandiera con due angoli a punta. Interpreta il testo scritto all’interno del riquadro come un messaggio da inviare ogni volta che il riquadro viene attivato da un altro messaggio in arrivo o dal clic del mouse. In quest’ultimo caso, per esempio, può essere usato come pulsante per attivare o meno una funzione.

Numero

Il riquadro “numero” è un tipo particolare di casella grafica con il lato superiore smussato e ha un comportamento diverso da altri riquadri che includono pulsanti e interruttori quadrati.

Il numero riflette il valore corrente dell’oggetto collegato oppure può venire utilizzato per il controllo numerico dell’oggetto. In pratica, si può puntare il mouse sul numero e trascinare verso l’alto e verso il basso il mouse per modificare il valore numerico; in alternativa, si può puntare il mouse sul numero e digitare il valori nel riquadro, premendo Invio al termine.

Modalità di inserimento

Per inserire i vari riquadri oggetto, messaggio e numero, agire dal menu Put e selezionare il tipo di riquadro da inserire (Figura 4.15), oppure usare le scorciatoie da tastiera che vengono mostrate fra parentesi.

Obiect (Ctrl+1).

Message (Ctrl+2).

Number (Ctrl+3).

Symbol (Ctrl+4).

Comment (Ctrl+5).
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Figura 4.15 Menu Put con le voci dei riquadri inseribili.

Notare che si possono inserire anche riquadri di tipo Symbol e Comment. Un “simbolo” è un altro modo di immagazzinare e trasmettere informazioni. Una volta creato, è possibile utilizzarlo per visualizzare l’output di alcuni oggetti, oppure si può digitare direttamente al suo interno e premere Invio per inviare il testo all’oggetto.

Un “commento” è un modo pratico per apporre note, per ricordare la funzione di un dato oggetto o per fornire informazioni ad altri.


Oggetti GUI

Oltre ai riquadri visti sopra, Pure Data mette a disposizione una libreria interna di oggetti GUI, ovvero dotati di interfaccia grafica (Figura 4.16). Sempre dal menu Put sono disponibili i seguenti oggetti GUI.

Bang (Shift+Ctrl+b).

Toggle (Shift+Ctrl+t).

Number2 (Shift+Ctrl+n).

Vslider (Shift+Ctrl+v).

Hslider (Shift+Ctrl+h).

Vradio (Shift+Ctrl+d).

Hradio (Shift+Ctrl+ i)

VU (Shift+Ctrl+u).

Canvas (Shift+Ctrl+c).

Graph.

Canvas.
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Figura 4.16 Oggetti GUI e la finestra Properties in cui editare i parametri delle proprietà dell’oggetto.

Bang

Questo oggetto GUI invia un messaggio chiamato “Bang” ogni volta che viene cliccato. Si tratta di un messaggio che gli oggetti interpretano come “agisci subito!”. Creare un oggetto Bang equivale a creare un riquadro messaggio con dentro la parola “Bang”. È utile usarlo quando si vuole attivare una funzione in un secondo tempo.

Toggle

È un pulsante che alterna il suo valore. Il pulsante Toggle invia uno dei due valori alternativamente, di solito 0 oppure 1.

Number2

Si tratta di un oggetto quasi identico al riquadro numero. Ha altre opzioni nelle sue proprietà, tra cui la possibilità di salvare il suo valore corrente quando la patch viene salvata (cambiando la casella init). Number2 ha un ingresso che può essere utilizzato per visualizzare i numeri in ingresso e si comporta sempre come “slider” con il mouse.

Vslider e Hslider
Questi sono, rispettivamente, un cursore verticale e uno orizzontale. Inviano il loro valore in base allo spostamento del mouse. L’intervallo predefinito del cursore è 0-127, ma può essere cambiato nelle proprietà. Entrambi i cursori hanno un ingresso che può essere utilizzato per visualizzare i numeri in ingresso entro l’intervallo predefinito del cursore.

Vradio e Hradio
Sono pulsanti d’opzione orizzontali o verticali. Inviano il loro valore quando una delle caselle viene cliccata. La dimensione predefinita di un pulsante d’opzione è di 8 caselle, ma può essere modificata nelle proprietà. Entrambi i pulsanti hanno un ingresso che può essere utilizzato per visualizzare numeri interi nell’intervallo predefinito dei pulsanti.

VU

È un misuratore VU (Volume Unit) che visualizza il livello medio del volume in decibel di qualsiasi segnale audio collegato a esso. È possibile cambiare i valori della scala sul lato destro nelle proprietà oppure nasconderla (no_scale).

Canvas

È un’area rettangolare di pixel, la cui dimensione e colore possono essere modificati nelle proprietà. Serve esclusivamente per creare sfondi in una patch per migliorare l’aspetto visivo e la leggibilità.

Il canvas può essere utilizzato anche come oggetto GUI per raccogliere informazioni della posizione (x, y).

Array

Un oggetto “array” è un modo di salvare e manipolare funzioni numeriche in modo grafico. Funziona come un plotter X/Y, ovvero è possibile inviare valori rappresentabili graficamente sull’asse X, restituiti poi sull’asse Y in base al tempo di elaborazione del segnale.

Prima di creare un array, appare una finestra di dialogo in cui si possono modificare le proprietà di disegno della matrice grafica:

save contents: salva i contenuti (consigliato);

draw as points: disegna come punti;

polygon: disegna linea poligonale (consigliato);

bezier curve: disegna curva di Bezier;

in new graph: nel nuovo grafico (consigliato);

in last graph: nell’ultimo grafico;

In un array è possibile fare clic sulla parte interna della linea e disegnare curve direttamente con il mouse. Gli array possono inoltre essere riempiti con informazioni provenienti da file di dati o da file audio (forme d’onda), così come da funzioni matematiche.

Graph

Si tratta di un contenitore “grafico” che può contenere più array.

Modalità Edit

La patch Pd funziona quando è in modalità di “esecuzione”, ovvero quando si esce dalla modalità Edit. In modalità Edit, la patch “attende” che vengano apportate le modifiche e le aggiunte di oggetti, di messaggi e così via. Si entra in modalità Edit dal menu Edit oppure, più semplicemente, con la scorciatoia da tastiera Ctrl+E.

Quando Pure Data è in modalità Edit, il cursore del mouse diventa una manina, altrimenti è una freccia.

I riquadri e gli oggetti GUI possono venire posizionati nella finestra della patch in qualsiasi modo. I collegamenti vengono effettuati con il mouse, “tirando” il filo da un oggetto all’altro, in corrispondenza degli ingressi e delle uscite.

Per sapere cosa si può collegare, ogni riquadro contiene dei piccoli rettangoli. Quelli sul lato superiore sono “ingressi” e quelli sul lato inferiore sono “uscite”.

Avvicinando il mouse a un ingresso o a un’uscita, il cursore diventa di forma circolare. A questo punto si può trascinare il mouse verso un ingresso o un’uscita di un altro oggetto. Quando il filo viene condotto verso la destinazione corretta, il cursore diventa ancora di forma circolare e quindi si può rilasciare il mouse, creando così il collegamento (Figura 4.17a). Notare che il piccolo rettangolo si colora in blu quando è disponibile per il collegamento, altrimenti rimane bianco.

Se si vuole interrompere un collegamento, basta avvicinare il mouse al filo; il cursore diventa una X e il filo si colora di blu (Figura 4.17b). A questo punto basta premere il tasto Canc per eliminare il filo e quindi il interrompere il collegamento fra i rettangoli. Si può usare anche il comando Cut dal menu Edit.
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Figura 4.17 Collegamento degli oggetti con il mouse (a). Eliminazione di un collegamento (b).

Non esistendo una regola precisa per posizionare gli elementi nella finestra della patch, si consiglia comunque di sistemare gli oggetti e di collegarli nel modo più ordinato possibile, onde evitare grovigli di fili inestricabili.

Una patch di prova

Dopo aver visto a grandi linee il funzionamento di base di Pure Data, possiamo iniziare a “programmare” una patch. Evitando il banalissimo “Hello World” che di solito si trova come incipit di tutti i libri che parlano di programmazione, ci dedicheremo a qualcosa di più produttivo e “musicale”, anche se di altrettanto semplice. Ecco la procedura spiegata passo passo.

Nuova finestra

Dal menu File > New, oppure con Ctrl+N, aprire una finestra vuota.

Inserire oggetti

Dal menu Put oppure con Ctrl+1, inserire un oggetto e digitare osc~. (Figura 4.18a).

Inserire ancora un oggetto e digitare *~ (Figura 4.18b).

Inserire ancora un oggetto e digitare dac~ (Figura 4.18c).
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Figura 4.18 Una semplice patch di Pure Data.

NOTA

Il simbolo tilde (~) corrisponde al carattere ASCII 126 (esadecimale 7E). Si può inserire premendo ALT+126 del tastierino numerico, oppure da Raspbian ALT GR+tasto ^.

Inserire messaggi

Dal menu Put, oppure con Ctrl+2, inserire un messaggio e digitare 0.1.

Dal menu Put, oppure con Ctrl+2, inserire un secondo messaggio e digitare 0 (Figura 4.18d).

Inserire numeri

Dal menu Put, oppure con Ctrl+3, inserire un riquadro numero. Verrà visualizzato 0 all’interno del riquadro (Figura 4.18e).

Effettuare i collegamenti

Con il mouse e la tecnica spiegata in precedenza, collegare i rettangoli di ingresso e uscita dei vari riquadri come indicato nella Figura 4.18f, non importa in quale ordine. Fintantoché non si esce dalla modalità Edit, la patch non è attiva.

Ecco quello che è stato creato fin qui:

l’oggetto osc~ crea un oscillatore sinusoidale;

l’oggetto *~ crea un moltiplicatore;

l’oggetto dac~ crea un convertitore digitale analogico;

il messaggio 0 manda il valore 0 all’ingresso del circuito dac;

il messaggio 0.1 manda il valore 0,1 all’ingresso del circuito dac;

la casella numero manda numeri da -∞ a +∞ all’ingresso dell’oscillatore osc.

Ecco come funziona.

Facendo clic sul messaggio 0.1 si attiva il segnale audio all’ingresso del dac con il 10% di ampiezza (volume massimo moltiplicato per 0,1).

Facendo clic sul messaggio 0 si porta a zero il volume all’ingresso del dac.

Variando il numero puntando il mouse al suo interno e muovendolo verso l’alto o il verso il basso, si sentirà la frequenza dell’oscillatore variare in base allo spostamento del mouse.

NOTA

Se non si sente alcun suono, bisogna attivare l’audio del circuito tramite la casella DSP, oppure dal menu Media.

Aggiungere un display

Per completare l’opera, si possono aggiungere alcuni elementi visuali alla patch. Per esempio si può dotare la patch di un display per monitorare la forma d’onda in uscita.

Ecco come fare, in breve.

Aggiungere un oggetto e digitare tabwrite~ array1.

Aggiungere un oggetto e digitare metro 10.

Aggiungere un oggetto GUI bang.

Aggiungere un oggetto GUI array lasciando il nome di default array1.

Collegare questi oggetti come indicato nella Figura 4.19a. I nuovi oggetti funzionano nel modo seguente.

L’oggetto tabwrite~ array1 manda i dati dell’oscillatore all’ingresso dell’oggetto array1.

L’oggetto metro controlla la frequenza del segnale all’ingresso dell’oggetto tabwrite.

L’oggetto bang inizializza l’oggetto metro e fa partire la visualizzazione su array1.

L’oggetto array1 visualizza la forma d’onda dell’oscillatore osc.

Aggiungere uno slider

Tutto bello fin qui, ma manca ancora qualcosa. Il messaggio 0.1 manda un valore fisso pari a un decimo (0,1) dell’ampiezza del segnale (volume) all’ingresso del dac. Volendo variare l’ampiezza del segnale, ovvero il volume di uscita dell’oscillatore e quindi anche modificare l’ampiezza della forma d’onda visualizzata su array1, è necessario aggiungere un oggetto Hslider (o Vslider, se si vuole).

Dato che il range di uscita audio viene calcolato nell’intervallo da 0 a 1, bisogna impostare nelle proprietà dell’oggetto Hslider i valori di output range a 0 per il parametro left e a 1 per il parametro right. In questo modo, agendo sullo slider si modificherà l’uscita del segnale da zero fino al valore massimo di uscita.

Per ottenere questo, però, è necessario reimpostare il valore 0.1 del messaggio a $1, ovvero rendere il valore variabile, come indicato nella Figura 4.19b. Effettuare il collegamento da Hslider al riquadro con il messaggio $1, come indicato dal tondo nella Figura 4.19b.
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Figura 4.19 È stato aggiunto un display e un controllo Bang (a). È Stato aggiunto uno slider orizzontale e il valore del messaggio è stato impostato a $1 (b).

Risorse

Pure Data dispone di una vasta serie di librerie e di altre risorse che vengono aggiornate costantemente dalla community online, molto attiva sul sito http://www.puredata.info e sul portale www.puredata.info. Esiste anche una community italiana all’indirizzo http://www.puredata.it che offre alcune risorse online e un forum.

Arduino

La documentazione su come sviluppare progetti per Arduino con Pure Data è disponibile sul sito dedicato a Pduino, all’indirizzo http://at.or.at/hans/pd/objects.html.

Miller Puckette

Miller Puckette è direttore associato del Center for Research in Computing and the Arts, nonché professore di musica presso l’Università della California di San Diego.

Puckette è noto per la creazione di Max, un ambiente di sviluppo grafico per la musica e la sintesi multimediale, sviluppato presso l’IRCAM alla fine degli anni Ottanta. È autore di Pure Data e mette a disposizione sul sito http://crca.ucsd.edu/~msp/tutta la documentazione relativa al software e molte altre risorse sulla musica elettronica.

Open Sound Control

Il protocollo Open Sound Control (OSC) nasce nel 1997 come uno studio di Adrian Freed e Matt Wright per lo sviluppo di una piattaforma di messaggistica tra computer, sintetizzatori audio e altri dispositivi multimediali in ambiente di networking. Nato presso il CNMAT (Center for New Music and Audio Technologies) dell’Università di Berkeley, il protocollo è di libero utilizzo ed è ormai implementato in numerose applicazioni di sviluppo multimediale, in molti software musicali e in alcuni controller hardware.

Originariamente previsti per la condivisione di dati musicali, come alternativa al MIDI, i messaggi OSC sono comunemente trasportati attraverso Internet e all’interno di sottoreti utilizzando protocolli UDP.

I messaggi OSC da controllori gestuali (touchpad, Wii e affini) sono generalmente trasmessi su reti wireless e controllano in tempo reale dispositivi finali di qualsiasi tipo.

In pratica, una volta programmato un software compatibile OSC, si può creare un’applicazione software in grado di controllare un dispositivo remoto, senza bisogno di un collegamento fisico di cavi o altro.

Implementazioni

Sul sito ufficiale http://www.opensoundcontrol.org sono elencati tutti i prodotti software e hardware che hanno adottato il protocollo Open Sound Control.

Nel nostro piccolo, applicheremo il codice di controllo OSC ad alcune applicazioni su Raspberry Pi.

Caratteristiche del protocollo

Le implementazioni OSC hanno avuto successo nella trasmissione in tempo reale in ambienti di elaborazione multimediale, strumenti di interattività web, sintetizzatori soft­ware, linguaggi di programmazione e dispositivi hardware.

Ma il protocollo OSC ha ottenuto largo impiego in settori che comprendono nuove interfacce computer-based per l’espressione musicale, la robotica e le performance visuali in sistemi di rete distribuita.

Ecco alcuni punti essenziali del protocollo.

I messaggi OSC contengono coppie nome/valore e un tag di tempo opzionale.

I valori sono chiamati in uno spazio gerarchico di nomi, che ricorda un percorso Unix o un URL.

I tipi di valore sono rappresentati in una stringa compatta.

I valori sono rappresentati in forma binaria con allineamento a 4 byte.

I tipi di base supportati sono due interi signed a 32 bit.

Supporta numeri a 32 bit in virgola mobile IEEE.

Terminazione null array di 8 bit di dati codificati (stringhe stile C).

Blob di dimensione arbitraria (dati audio o fotogramma video).

I vantaggi di OSC rispetto al MIDI sono principalmente la velocità, la connettività internet, il tipo di risoluzione dei dati e la relativa facilità di specificare un percorso simbolico invece di specificare tutti i tipi di dati dei collegamenti su bus a 8 bit, ovvero messaggi di 7 bit o al massimo 14 bit del protocollo MIDI.

Specifiche OSC

Premesso che le specifiche complete sono disponibili presso il sito ufficiale http://www.opensoundcontrol.org, ci limitiamo a illustrare solo qualche esempio di implementazione del protocollo OSC, relativo alle stringhe OSC.

Esempi di stringa OSC 

Una stringa “OSC” è rappresentata come quattro byte:

O
S
C
\0

La stringa “dati” è rappresentata come otto byte:

d
a
t
a
\0 
\0 
\0 
\0

Esempi di OSC Type Tag String

	Un argomento float32
	,f

	Due argomenti int32 seguita da una stringa OSC seguiti da tre argomenti float32 
	,iisfff

	Nessun argomento
	,

	Un argomento int32 seguito da due argomenti Blob OSC
	,ibb


Indirizzo OSC

Supponiamo che un particolare spazio di indirizzi OSC includa un metodo OSC con il nome frequency.

Questo metodo è contenuto in un contenitore con il nome OSC 3, che è contenuto in un altro contenitore OSC chiamato resonators, che è contenuto nel contenitore OSC che è la radice dell’albero. L’indirizzo OSC diventa /resonators/3/frequency.

Un altro esempio. L’indirizzo OSC /a/b/c/d/e significa che:

la radice dell’albero contiene un contenitore OSC con il nome a;

il contenitore OSC contiene un contenitore OSC con il nome b;

il contenitore OSC contiene un contenitore OSC con il nome c;

il contenitore OSC contiene un contenitore OSC con il nome d;

e che il contenitore OSC contiene un metodo OSC con il nome e.

Esempi di messaggistica OSC

In ognuno di questi esempi, ogni byte di un messaggio è stampato prima in esadecimale, seguito dal carattere ASCII corrispondente tra parentesi.

Esempio 1

Il messaggio OSC con il pattern dell’indirizzo OSC /oscillator/4/frequency e il numero in virgola mobile 440,0 come il singolo argomento sarebbero rappresentati dal seguente messaggio a 32 byte:

	2f
	(/)
	
	6f
	(o)
	
	73
	(s)
	
	63
	(c)
	/osc

	69
	(i)
	
	6c
	(l)
	
	6c
	(l)
	
	61
	(a)
	illa

	74
	(t)
	
	6f
	(o)
	
	72
	(r)
	
	2f
	(/)
	tor/

	34
	(4)
	
	2f
	(/)
	
	66
	(f)
	
	72
	(r)
	4/fr

	65
	(e)
	
	71
	(q)
	
	75
	(u)
	
	65
	(e)
	eque

	6e
	(n)
	
	63
	(c)
	
	79
	(y)
	
	0
	()
	ncy

	2c
	(,)
	
	66
	(f)
	
	0
	()
	
	0
	()
	,f00

	43
	(C)
	
	dc
	(Ü)
	
	0
	()
	
	0
	()
	CÜ00


Applicando la conversione float 32 (IEEE 754) all’ultima riga della tabella, si ottiene:

esadecimale = 4 3 D C 0 0 0 0

binario = 0100 0011 1101 1100 0000 0000 0000 0000

numero in precisione doppia = 440,0 (il valore della frequenza in virgola mobile)

Per la conversione gratuita online IEEE 754 vedi il link http://www.h-schmidt.net/FloatApplet/IEEE754.html.

A titolo di esempio, modificando la frequenza di 1 decimo di hertz (0,1 Hz), ovvero portando il valore decimale da 440,0 a 440,1, con la conversione a 32 bit in virgola mobile (float 32) si ottiene:

esadecimale = 4 3 D C 0 C C D

binario = 0100 0011 1101 1100 0000 1100 1100 1101

numero in precisione doppia = 440,1000061035156 (il valore della frequenza in virgola mobile)

Esempio 2

L’esempio mostra una rappresentazione a 40 byte di un messaggio OSC con il pattern di indirizzo OSC /foo e 5 argomenti:

int32 1000

int32 -1

La stringa “hello”

float32 1.234

float32 5.678

	2f
	(/)
	
	66
	(f)
	
	6f
	(o)
	
	6f
	(o)
	/foo

	0
	()
	
	0
	()
	
	0
	()
	
	0
	()
	0000

	2c
	(,)
	
	69
	(i)
	
	69
	(i)
	
	73
	(s)
	,iis

	66
	(f)
	
	66
	(f)
	
	0
	()
	
	0
	()
	ff00

	0
	()
	
	0
	()
	
	3
	()
	
	e8
	(è)
	003è

	ff
	(ÿ)
	
	ff
	(ÿ)
	
	ff
	(ÿ)
	
	ff
	(ÿ)
	ÿÿÿÿ

	68
	(h)
	
	65
	(e)
	
	6c
	(l)
	
	6c
	(l)
	hell

	6f
	(o)
	
	0
	()
	
	0
	()
	
	0
	()
	o000

	3f
	(?)
	
	9d
	()
	
	f3
	(ó)
	
	b6
	(¶)
	?9dò¶

	40
	(@)
	
	b5
	(µ)
	
	b2
	(“)
	
	2d
	(-)
	@µ”-


Ordine di invocazione dei metodi OSC che corrispondono ai messaggi OSC in un bundle OSC

Prendiamo uno spazio di indirizzi di server OSC che include i metodi con i seguenti indirizzi OSC:

/first/this/one
/second/1
/second/2
/third/a
/third/b
/third/c

Supponiamo che un bundle OSC venga ricevuto con tre messaggi OSC e che i tre messaggi OSC abbiano questi pattern di indirizzo OSC:

/first/this/one
/second/[1-2]
/third/*

Verranno invocati sei metodi in questo ordine.

(1) Prima /first/this/one, da quel pattern di indirizzo OSC apparso prima nel bundle OSC, poi...

(2-3) sia /second/1 seguito da /second/2 o /second/2 seguito da /second/1, poi...

(3-6) /third/a, /third/b e /third/c, in qualsiasi ordine.

Ci sono dodici ordini possibili in cui un server OSC può invocare questi sei metodi.

/first/this/one, /second/1, /second/2, /third/a, /third/b, /third/c

/first/this/one, /second/1, /second/2, /third/a, /third/c, /third/b

/first/this/one, /second/1, /second/2, /third/b, /third/a, /third/c

/first/this/one, /second/1, /second/2, /third/b, /third/c, /third/a

/first/this/one, /second/1, /second/2, /third/c, /third/a, /third/b

/first/this/one, /second/1, /second/2, /third/c, /third/b, /third/a

/first/this/one, /second/2, /second/1, /third/a, /third/b, /third/c

/first/this/one, /second/2, /second/1, /third/a, /third/c, /third/b

/first/this/one, /second/2, /second/1, /third/b, /third/a, /third/c

/first/this/one, /second/2, /second/1, /third/b, /third/c, /third/a

/first/this/one, /second/2, /second/1, /third/c, /third/a, /third/b

/first/this/one, /second/2, /second/1, /third/c, /third/b, /third/a

Da sottolineare che presso il sito CNMAT dell’Università di Berkeley è disponibile il pacchetto gratuito OpenSound Control Kit, per Mac e Unix, all’indirizzo http://archive.cnmat.berkeley.edu/OpenSoundControl/Kit/.

Nella stessa pagina, oltre alle istruzioni per l’implementazione OSC nelle proprie applicazioni, ci sono vari strumenti gratuiti per la scrittura di client OSC, senza dover implementare l’intero kit OSC.

Touchpad come controller Wi-Fi

L’idea di poter controllare un dispositivo remoto tramite il touchpad di un tablet o di uno smartphone è sicuramente entusiasmante.

Per gli scopi prefissati di questo libro è sufficiente essere attrezzati di hardware e software facili da reperire o già disponibili in casa. Per i felici possessori di iPad, iPhone o iPod touch le cose vanno un po’ meglio; per i possessori di tablet e smartphone Android un po’ meno.

Tramite la rete Wi-Fi di casa, il dispositivo mobile e un software, è possibile programmare senza eccessivi sforzi un sistema di controllo “touch” senza fili del nostro robot, aereo, elicottero, auto, trenino e quant’altro.

Purtroppo lo sviluppo del software si è rivolto verso la piattaforma di maggior successo, e non ce ne vogliano i sostenitori del “tutto gratis” e dell’open source o di altre piattaforme. In questa parte del capitolo ci dedicheremo a spiegare un’applicazione particolarmente efficace in ambiente iOS e, limitatamente, anche in ambiente Android. Nulla sembra esistere per le piattaforme Windows Mobile, Blackberry o altre.

TouchOSC

Delle poche applicazioni Open Sound Control disponibili in Rete, abbiamo scelto TouchOSC, sicuramente la più diffusa, ma anche la più semplice da programmare e da implementare su dispositivi iOS e Android.

TouchOSC è un’applicazione prodotta da hexler.net, disponibile a pagamento per iPhone, iPod touch, iPad e gratuitamente per Android.

L’installazione del client TouchOSC è semplicissima: basta recarsi sul sito di Apple iTunes per la versione iOS e sul sito di Google Play per la versione Android e scaricare l’applicazione TouchOSC sul proprio dispositivo mobile, tablet o smartphone.

Una volta avviato il client sul proprio device, sarà sufficiente impostare i pochi parametri OSC e inserire l’indirizzo della propria rete Wi-Fi per comunicare con l’applicazione server installata nel computer.

Esempio di comunicazione OSC

Premesso di voler usare la rete Internet Wi-Fi domestica, supponiamo di voler controllare una serie di fader virtuali programmati in precedenza su Pure Data. Quest’ultimo, come sappiamo, è collegato via audio e MIDI alla scheda audio del computer e a strumenti MIDI interni ed esterni. Questo permette, fin da subito, di controllare suono e MIDI da posizione remota tramite il touchpad di un dispositivo mobile, per esempio suonare in Wi-Fi con l’iPad un pianoforte campionato caricato in un campionatore OSC o MIDI.

Oltre a ciò, vedremo in seguito come controllare qualsiasi altra cosa (motori, luci e quant’altro) collegando nella stessa rete un dispositivo autocostruito in grado di ricevere i comandi dal dispositivo mobile collegato via OSC a Pure Data; in pratica, controllare un dispositivo robotico a distanza via Wi-Fi tramite touchpad.

Per prima cosa, è consigliabile scaricare il file basic.pd dal sito hexler.net e aprirlo con Pure Data. Una volta aperto il file, bisognerà impostare correttamente i parametri per le porte di connessione OSC e l’indirizzo di rete (Figura 4.30) del dispositivo di controllo.


Invio e ricezione di messaggi OSC

In questo esempio e in quelli successivi, utilizzeremo un iPad per comunicare i dati OSC da e verso Pure Data.
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Figura 4.30 Il file basic.pd caricato in Pure Data. Sono visibili i parametri delle porta OSC e l’indirizzo di rete.

Come illustrato nella Figura 4.30, Pure Data è già pronto per ricevere e trasmettere i messaggi OSC da e verso l’applicazione TouchOSC caricata nell’iPad.

Analizzando la finestra del file basic.pd, notiamo i seguenti elementi:

a sinistra, l’oggetto dumpOSC 8000 indica che Pure Data è in ascolto dei messaggi OSC sulla porta numero 8000;

la casella con il testo print osc indica che i dati OSC ricevuti sulla porta 8000 verranno stampati a video nella finestra di debug di Pure Data;

a destra, una casella con il messaggio connect 10.10.10.10 9000 riporta l’indirizzo di trasmissione (che andrà opportunamente cambiato) sulla porta 9000;

la casella send /1/fader1 1 indica il tipo di comando OSC da trasmettere tramite l’oggetto sendOSC.

Entrando in modalità Edit di Pure Data (Ctrl+e) è possibile modificare sia la porta di ricezione sia di trasmissione, anche se è consigliabile lasciare i valori di default, ovvero 8000 per la ricezione e 9000 per la trasmissione.

Sarà invece necessario modificare l’indirizzo IP e inserire i valori esatti al posto dell’indirizzo 10.10.10.10 di esempio.

Indirizzo IP di trasmissione

Per utilizzare l’indirizzo IP di trasmissione è necessario conoscere l’indirizzo IP di ricezione dell’iPad. Dal pannello Impostazioni > Wi-Fi dell’iPad, la prima voce riporta l’indirizzo IP. Nel nostro caso è 192.168.1.4 e andrà a sostituire l’indirizzo 10.10.10.10 riportato nel file di esempio di Pure Data, visto prima.

Indirizzo IP di ricezione

Per conoscere l’indirizzo IP di ricezione, ovvero quello della scheda installata nel proprio computer, basta entrare nelle proprietà di connessione di rete e trascrivere i dati. Per esempio, sotto Windows, basta digitare ipconfig al prompt dei comandi, oppure entrare nelle proprietà della scheda di rete. In Mac OS X, basta aprire il pannello Preferenze di Sistema e entrare nel pannello Network.

Qualunque metodo si usi, quello da trovare è un tipico indirizzo IPv4, usato nella categoria dei cosiddetti IP privati, che rientra nell’intervallo da 192.168.0.0 a 192.168.255.255. Per cui, nella maggior parte dei casi, l’indirizzo IP da inserire dovrebbe assomigliare a 192.168.x.x, dove x sono numeri assegnati dal sistema alla scheda di rete. Nel nostro esempio, l’indirizzo trovato è 192.168.1.2. 

Come vedremo, questo indirizzo andrà inserito nel pannello di configurazione di TouchOSC, caricato nell’iPad.

Configurazione dell’iPad

Dopo avere avviato l’applicazione TouchOSC, si aprirà la finestra di configurazione, come illustrato nella Figura 4.31.
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Figura 4.31 Finestra di configurazione TouchOSC su iPad.

Da questa finestra si può accedere a vari menu.

Connections: impostazione dell’indirizzo OSC, MIDI Mobilizer, CoreMIDI.

Layout: impostazione del layout OSC.

Options: impostazioni delle opzioni dell’interfaccia.

About: crediti e sito web di hexler.

La voce che interessa è Connections, che aprirà un menu per attivare la connessione. Le voci di impostazione sono le seguenti, come illustrato nella Figura 4.32:

Host;

Port (outgoing);

Port (incoming);

Local IP address.
Alla voce Host si dovrà inserire l’indirizzo IP della rete. Nell’esempio, l’indirizzo IP è 192.168.1.2. Questo permetterà all’iPad di trasmettere i dati OSC a Pure Data.

Alla voce Port (outgoing) si dovrà controllare che sia inserito il valore 8000, mentre alla voce Port (incoming) dovrà essere assegnato il numero 9000. In pratica dovranno essere le stesse porte che sono impostate nell’esempio di Pure Data.

Come già accennato, è possibile scegliere due numeri di porta qualsiasi delle 65 536 disponibili del protocollo UDP, ma è consigliabile lasciare le cose come stanno, anche perché 8000 e 9000 sono due numeri che appariranno spesso nelle applicazioni OSC.

Notare che alla voce Local IP address il valore preimpostato (192.168.1.4) appare disattivato e non può essere cambiato in quanto è quello assegnato dal sistema alla scheda di rete interna dell’iPad. A questo punto, l’iPad è in grado di trasmettere e ricevere via Wi-Fi.
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Figura 4.32 Configurazione dell’indirizzo IP e delle porte OSC.

Scegliere il layout

Una volta configurati gli indirizzi IP e le porte di ricezione e trasmissione, è necessario caricare un layout, ovvero un’interfaccia grafica di controllo.

Prima di imparare a costruire da zero la propria interfaccia grafica, è consigliabile caricare un layout già pronto per testare la comunicazione fra l’iPad e Pure Data.

Toccando la voce Layout dalla finestra di configurazione di TouchOSC è possibile accedere al menu per la scelta dei layout disponibili, come illustrato nella Figura 4.33.

Nell’installazione originale di TouchOSC, sono disponibili alcuni layout per usi generici:

Beatmachine;

Keys;

LogicPad;

Mix 16;
Mix 2;
Simple.

Per il nostro esempio useremo il layout Simple. Una volta caricato il layout, basterà toccare il pulsante Done della finestra di configurazione per vedere l’interfaccia grafica corrispondente. La Figura 4.34 illustra il layout Simple, in cui sono visibili quattro fader verticali, quattro pulsanti e un fader orizzontale.
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Figura 4.33 Il menu Layout di TouchOSC.
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Figura 4.34 Il layout Simple di TouchOSC.

Test del layout

Per provare la trasmissione e ricezione di dati OSC da e verso Pure Data tramite l’interfaccia TouchOSC, è sufficiente creare la connessione facendo clic sul pulsante connect 192.168.1.4 9000 della finestra basic.pd (come indicato dalla freccia a sinistra nella Figura 4.35). Ricordiamo che l’indirizzo IP utilizzato qui è puramente a titolo di esempio.
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Figura 4.35 Il primo fader del layout Simple al massimo, alla ricezione del comando send /1/fader1 1 dall’interfaccia di Pure Data.

Facendo clic sul pulsante send /1/fader1 1 (freccia al centro della Figura 4.35) si trasmetterà il valore 1 al fader 1. Di conseguenza si vedrà il primo fader del layout Simple alzarsi istantaneamente al valore massimo, come illustrato dalla freccia nella Figura 4.35.

Per provare invece la trasmissione di dati OSC dall’iPad verso Pure Data, è sufficiente muovere qualsiasi fader o pulsante dell’interfaccia Simple. Nella finestra di debug di Pure Data verranno stampati tutti i valori corrispondenti ai controlli OSC dei fader e dei pulsanti. La Figura 4.36 illustra i valori numerici corrispondenti agli spostamenti effettuati sui fader del layout Simple, ovvero la serie di dati ricevuti da Pure Data.


Creare e modificare controlli con Pure Data

Abbiamo visto che con pochi elementi di controllo del file basic.pd si può stabilire un contatto Wi-Fi con l’iPad. Ma per capire meglio il funzionamento del protocollo OSC abbiamo voluto creare ulteriori controlli con Pure Data, modificando il file basic.pd usato per il test di prova.

Ecco una procedura veloce per aggiungere altri tre controlli OSC all’interfaccia di Pure Data. Avremo così quattro controlli per i quattro fader del layout Simple.

Dal menu Edit, entrare in Edit Mode (Ctrl+e).

Dal menu Put selezionare Message (Ctrl+2).

Digitare nella casella send /1/fader2 1.
Dal menu Put selezionare Message (Ctrl+2).

Digitare nella casella send /1/fader3 1.
Dal menu Put selezionare Message (Ctrl+2).

Digitare nella casella send /1/fader4 1.
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Figura 4.36 I controlli del layout Simple e la serie di dati ricevuti da Pure Data, nel nostro caso relativi ai movimenti del fader 1.

Il risultato fin qui ottenuto è visibile nella Figura 4.37a. Si vedono in totale quattro controlli di cui solo il primo è collegato. Non ci resta che collegare l’uscita degli altri messaggi send all’ingresso dell’oggetto sendOSC, come illustrato nella Figura 4.37b.

Ricordarsi di uscire da Edit Mode da menu o premendo Ctrl+e.
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Figura 4.37 Sono stati aggiunti tre controlli send (a). I controlli send vengono collegati all’oggetto sendOSC (b). Nell’interfaccia Simple i quattro fader sono al valore massimo (c).

A questo punto, facendo clic sui quattro messaggi send si vedranno i quattro fader dell’interfaccia Simple alzarsi al massimo, come illustrato nella Figura 4.37c.

Per completare l’opera e comprendere appieno il funzionamento dei controlli send, se ne possono aggiungere altri quattro, usando lo stessa procedura. Questa volta il messaggio è del tipo send /1/fader1 0, ovvero con il valore da mandare al fader uguale a 0 (zero).

Dal menu Edit, entrare in Edit Mode (Ctrl+e).

Dal menu Put selezionare Message (Ctrl+2).

Digitare nella casella send /1/fader1 0.
Dal menu Put selezionare Message (Ctrl+2).

Digitare nella casella send /1/fader2 0.
Dal menu Put selezionare Message (Ctrl+2).

Digitare nella casella send /1/fader3 0.
Dal menu Put selezionare Message (Ctrl+2).

Digitare nella casella send /1/fader4 0.
Collegare l’uscita dei quattro messaggi send all’ingresso dell’oggetto sendOSC, come illustrato nella Figura 4.38a. Facendo clic su connect 192.168.1.4 9000 e sui quattro messaggi send si vedranno i quattro fader dell’interfaccia Simple abbassarsi al valore minimo, come illustrato nella Figura 4.38b. Questo perché il valore di ogni messaggio è impostato a 0.

Facendo clic sui precedenti controlli send con valore 1, i fader si alzeranno al valore massimo.
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Figura 4.38 Sono stati aggiunti altri quattro controlli send (a). I controlli send vengono collegati all’oggetto sendOSC (b). Nell’interfaccia Simple i 4 fader sono al valore minimo (c).

Aggiungere uno slider all’interfaccia (1)

Abbiamo visto che con il controllo send il valore impostato a 1 permette di alzare il fader al massimo, mentre il valore impostato a 0 lo porta al minimo.

Questo succede perché nel layout Simple (che viene fornito insieme al programma di installazione TouchOSC) i fader sono impostati con un valore massimo e minimo di 1 e 0, rispettivamente.

Volendo variare il valore del fader da 0 a 127, è necessario modificare il layout Simple e fare in modo che il fader risponda di conseguenza, cioè che il suo cursore si muova su e giù esattamente come un fader dovrebbe fare.

Per fare questo è necessario lanciare il programma TouchOSC Editor, come spiegato nel prossimo paragrafo.

TouchOSC Editor

TouchOSC Editor è disponibile gratuitamente per piattaforme Windows, Mac e Linux all’indirizzo http://www.hexler.net/software/touchosc. Notare che la versione per Linux è in formato Java e può funzionare anche su Raspberry Pi.

Dopo la modifica dei valori assegnati ai fader del layout Simple sarà possibile tornare all’interfaccia di Pure Data per aggiungere ulteriori controlli slider, tramite i quali si potrà agire sui fader facendoli scorrere su e giù. Non ci resta che dare un’occhiata all’interfaccia di TouchOSC Editor.

Una volta aperto il programma, la finestra principale si presenta simile a quella illustrata nella Figura 4.39. La finestra appare vuota, pertanto è necessario caricare un layout o crearne uno ex novo.
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Figura 4.39 La finestra principale di TouchOSC Editor.

Layout di default

Visto che dobbiamo modificare il layout Simple, si consiglia di scaricare dalla sezione download nella home page del sito hexler.net il file compresso touchosc-default-layouts.zip, contenente tutti i layout di default per TouchOSC. Ce ne sono per tutti i gusti e attualmente la lista completa comprende controlli per vari software e anche per diverse piattaforme DJ:

Beatmachine.touchosc

Jog-On.touchosc

Keys.touchosc

LogicPad.touchosc

LogicTouch.touchosc

Mix 16.touchosc

Mix 2 iPad.touchosc

Mix 2.touchosc

Simple.touchosc

ViZPad.touchosc

ViZPod.touchosc

Dalla cartella scompattata touchosc-default-layouts, carichiamo il file Simple.touchosc in modo che la finestra principale di TouchOSC Editor assomigli a quella illustrata nella Figura 4.40. Come si può vedere, il layout è identico a quello che si vede caricato nell’iPad.
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Figura 4.40 La finestra principale di TouchOSC Editor dopo aver caricato il layout Simple.

Gli strumenti di editing sono semplicissimi; per il momento, ci limitiamo a modificare il valore del primo fader, in modo che si possa proseguire con la succitata aggiunta dello slider in Pure Data.

Facendo clic sul primo fader è possibile far apparire i suoi parametri assegnati nel pannello di sinistra, come illustrato nella Figura 4.41a.
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Figura 4.41 Il valore del fader della casella To a 1 (a). Il valore del fader della casella To a 127 (b).

Tralasciando per il momento il resto, vediamo che nelle caselle Value Range il primo valore From è impostato su 0, mentre il secondo valore To è impostato su 1 (indicato dalla freccia). È esattamente quello abbiamo fatto poco fa con Pure Data: facendo clic sul messaggio send /1/fader1 1 oppure sul messaggio send /1/fader1 0, il fader del layout Simple va al valore massimo (1) oppure al valore minimo (0).

Basta modificare la casella To e inserire il valore 127 (indicato dalla freccia nella Figura 4.41b) perché il fader possa ricevere e trasmettere valori decimali da 0 a 127.

La ragione della scelta del numero 127 non è casuale ed è chiaramente legata alla consuetudine di trattare dati seriali su un bus a 8 bit (per esempio il MIDI). Volendo complicare le cose, si possono comunque gestire dati anche a 16, 24 bit o 32 bit in virgola mobile.

Una volta modificato il valore del primo fader, si può ripetere la stessa operazione per tutti i fader del layout.

Trasferimento del layout

Terminata questa semplice modifica del valore del fader, si può trasferire il layout all’iPad tramite la stessa connessione Wi-Fi preparata in precedenza.

Prima del trasferimento, è importante selezionare il tipo di layout nella casella Layout Size e impostarlo su iPad o su iPhone/iPod touch, a seconda del dispositivo mobile che si vuole utilizzare.

Quindi si procede al trasferimento attivando la sincronizzazione tramite il pulsante Sync della barra dei menu di TouchOSC Editor. Si attiva così la comunicazione Wi-Fi con l’iPad. Apparirà una finestra simile a quella della Figura 4.42a.

A questo punto, dalla finestra di configurazione di TouchOSC dell’iPad, è sufficiente selezionare Layout e subito dopo Add (Figura 4.42b).

Per aggiungere o sostituire il layout modificato basta premere OK nella finestra di dialogo che appare subito dopo (Figura 4.42c) e il layout Simple verrà caricato all’interno di TouchOSC.
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Figura 4.42 La finestra di Sync fra TouchOSC Editor e il dispositivo mobile (a). Il menu Add Layout di TouchOSC (b). L’avviso di sovrascrittura del layout (c).

Aggiungere uno slider all’interfaccia (2)
Come preannunciato, torniamo al file basic.pd di Pure Data. Ora è possibile aggiungere uno slider per controllare il fader modificato con i valori da 0 a 127.

Ecco come fare.

Dal menu Edit, entrare in Edit Mode (Ctrl+e).

Dal menu Put selezionare Vslider (Shift+Ctrl+v).

Aprire la finestra Properties di Vslider per verificare che i valori del pannello output range relativi a bottom e top siano impostati rispettivamente su 0 e 127. Di solito sono preimpostati e non serve fare nulla. Altrimenti, inserire il numero 127 nella casella top.

Il risultato di questa operazione è visibile nella Figura 4.43a. A questo punto, è importante modificare anche il valore del messaggio send /1/fader1 1 mettendo il simbolo di variabile ($) davanti a 1, in modo che diventi send /1/fader1 $1.

Infine, colleghiamo il controllo Vslider all’ingresso del messaggio send, come illustrato nella Figura 4.43b.

Uscendo dalla modalità Edit, si potrà agire sullo slider e contemporaneamente si vedrà il cursore del fader del layout Simple muoversi fra i valori minimo e massimo, ovvero da 0 a 127 (Figura 4.43c).
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Figura 4.43 È stato aggiunto un controllo Vslider (a). Il controllo Vslider viene collegato al controllo send (b). Nell’interfaccia Simple il fader si muove da 0 a 127 in corrispondenza del valore di Vslider (c).

Creare un layout con TouchOSC Editor

Dopo questo lavoro per modificare un layout già pronto, probabilmente si è in grado di creare un proprio layout partendo da zero.

Tenendo sott’occhio la Figura 4.44, ecco una procedura per creare velocemente un semplice layout. 

Dalla barra dei menu della finestra principale selezionare New.

Nella casella Layout Size selezionare iPad (o iPhone/iPod touch).

Nella casella Layout Orientation selezionare horizontal.

Notare che nella casella Page Name il nome assegnato in modo automatico è 1. È consigliabile lasciarlo così.

Con il tasto destro mouse selezionare Fader H dal menu contestuale, corrispondente a un fader orizzontale. Verrà aggiunto però un fader verticale perché il layout è stato orientato in orizzontale.

Dal menu contestuale del mouse è possibile aggiungere nel layout i seguenti controlli (V sta per Vertical e H sta per Horizontal):

LED;

Label V;
Label H;
Push Button;
Toggle Button;
XY Pad;
Fader V;
Fader H;
Rotary V;

Rotary H;
Encoder;
Battery V;
Battery H;
Time V;
Time H;
Multi-Push;
Multi-Toggle;
Multi-Fader V;
Multi-Fader H.
Ricordarsi al termine di selezionare Save nella barra del menu e dare un nome al file, per esempio “Prova”. Il file verrà salvato come Prova.touchosc.
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Figura 4.44 Layout ex novo con TouchOSC Editor. Il menu contestuale del mouse visualizza la lista dei controlli disponibili.

Proprietà dei controlli

Nella Figura 4.45 sono illustrati tutti i tipi di controllo aggiunti al layout. Selezionando un controllo nella finestra principale, sul lato sinistro appare il relativo pannello con le proprietà.

Di ogni controllo sono disponibili le seguenti proprietà.

Name: il nome del controllo viene dato in modo automatico, per esempio fader1, push1, multitoggle1 e così via, numerando progressivamente i controlli man mano che vengono aggiunti, per esempio fader2, push2, multitoggle2.

Color: il colore del controllo può essere scelto da una palette di sette colori.

X, Y, W e H: sono le coordinate X e Y corrispondenti alla posizione del controllo e le sue dimensioni (larghezza e altezza), modificabili anche con il mouse.

OSC: la casella auto stabilisce che il nome del controllo OSC venga dato in modo automatico (consigliato) oppure immesso manualmente.

MIDI: in questo pannello si può stabilire il tipo di evento MIDI da associare al controllo, per esempio Note, Program Change, Control Change e così via, così come il canale MIDI e il campo da 0 a 127 relativo al tipo di messaggio.

Value Range: per i valori From e To si possono inserire numeri qualsiasi, ma nel caso più tipico, 0 e 127.

A seconda del tipo di controllo, sono disponibili alcune proprietà specifiche. Per esempio, per il controllo fader è possibile impostare la proprietà Inverted, ovvero di inversione del senso di scorrimento del cursore, e la proprietà Centered, ovvero il posizionamento del cursore al centro del fader. La proprietà Response permette di impostare il comportamento Absolute o Relative: in modalità di risposta assoluta (Absolute) qualsiasi contatto sul fader effettua il salto del cursore nella posizione corrente del dito. In modalità di risposta relativa (Relative) il contatto iniziale non comporta alcun cambiamento e solo i movimenti successivi del dito sul cursore applicano la variazione del valore. Per esempio, un fader con risposta assoluta può essere toccato in qualsiasi punto cambiando la posizione del suo cursore a ogni tocco, mentre con risposta relativa è necessario muovere il cursore per modificare il valore del fader.
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Figura 4.45 Tutti i controlli disponibili disposti nel layout.

Strumenti di editing

Benché in forma minimale, sono presenti tutti gli strumenti principali per la modifica del layout grafico. Il menu contestuale di ogni controllo (Figura 4.46a) permette le seguenti operazioni.

Cut, Copy, Delete: classici strumenti corrispondenti a taglia, copia ed elimina.

Bring to front e Send to back: disposizione dei controlli su due livelli, quindi portati avanti e portati sotto.

Center: consente di posizionare il controllo al centro del layout in senso orizzontale o verticale.

Align: selezionando due o più controlli si possono allineare i rispettivi lati in alto, in basso, al centro, a destra, a sinistra o in mezzo.

Distribute: selezionando tre o più controlli si possono distribuire i rispettivi centri in senso orizzontale o verticale.

Aggiungere pagine

Come abbiamo visto, il protocollo OSC consente la paginazione e la scrittura dell’indirizzo in forma di URL, pertanto è possibile separare i controlli del layout in pagine separate.

Per aggiungere una pagina, basta collocare il mouse sulla parte alta del layout e aprire il menu contestuale con il tasto destro del mouse. Selezionando Add Page o Remove Page si possono aggiungere o rimuovere pagine al layout (Figura 4.46b).
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Figura 4.46 Il menu degli strumenti di editing (a) e quello per aggiungere o rimuovere pagine (b).

Quando si aggiungono pagine al layout, il nome OSC cambia di conseguenza e viene aggiunto al nome del controllo il numero di pagina separato dal simbolo / (barra).

Per esempio:

/1/fader1 corrisponde al nome del fader 1 della prima pagina;

/2/push1 corrisponde al nome del pulsante 1 della seconda pagina;

/3/rotary2 corrisponde al nome del controllo rotativo 2 della terza pagina.

Questo fa capire l’uso del messaggio send /1/fader1 che abbiamo visto in Pure Data  poc’anzi. Se andiamo a vedere, infatti, il layout Simple è formato da quattro pagine (Figura 4.47). Quindi il messaggio send /1/fader1 è riferito al fader 1 della prima pagina del layout.
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Figura 4.47 Il layout Simple è formato da quattro pagine.

Volendo mandare messaggi ai controlli delle altre pagine bisogna cambiare il messaggio e scrivere, per esempio, send /2/fader1 oppure send /3/fader4 e così via.

Una volta terminata la progettazione del proprio layout, è possibile trasferirlo tramite la connessione Wi-Fi all’iPad seguendo la procedura vista prima.

OSC per Android

Il software TouchOSC per la piattaforma Android è gratuito ma è limitato. Ha solo cinque layout precaricati che purtroppo non si possono modificare né trasferire tramite TouchOSC Editor. Al momento, lo sviluppatore non ha aggiornato il software e i layout sono utilizzabili così come sono, solamente modificando le applicazioni in Pure Data in base ai tipi di controlli presenti nei layout.

Nella versione Android sono disponibili, Simple, Mix 2, Mix 16, Keys e Beatmachine, illustrati nella Figura 4.48. Questi layout sono comunque ricchi di pagine e possono essere adattati a progetti Pure Data di vario tipo. Si consiglia di visitare il sito dello sviluppatore hexler.net per verificare la disponibilità di eventuali aggiornamenti a TouchOSC per la piattaforma Android.
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Figura 4.48 Layout disponibili in TouchOSC per Android.

Per dovere di cronaca, altre applicazioni OSC per Android sono:

OSC Control: gratuito, con alcuni layout interessanti ma ancora di sviluppo;

OSC-Controller: gratuito, con solo un fader e un pulsante, ma sono disponibili i file sorgenti;

andOSC: gratuito, solo per vedere alcuni parametri in funzione. Inutile.

